
Database Management Software Cases 
⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯ 

 

 

151

Database Case 2  
Hudson, Palmer, Martinez & Flenderson Attorneys-
at-Law  

Problem:  Construct a Personnel Database  

Management Skill:  Coordinate  

Access Skills:  Table Setup  
 Data Input  
 Select Queries  
 Report Design  
 Printing  

Data Table:  HUDSON PALMER  

Hudson, Palmer, Martinez, & Flenderson (Hudson Palmer for short) is a large legal practice 
with offices in Allentown, Harrisburg, and Scranton, Pennsylvania, specializing in corporate 
law. The Hudson Palmer Allentown office employs more than 85 freelance and contract 
personnel, including expert witnesses (EW) from various fields and disciplines, private 
investigators (PI), process servers (PS), and legal researchers (LR). These people are hired on 
an as-needed basis to assist in the conduct of cases on behalf of the many client corporations 
the firm represents.  

Hudson Palmer has 38 Principal attorneys who are also the main partners in the firm. Each 
Principal has a staff of assistant lawyers. In addition, all Principals keep separate lists of 
contractors and freelancers with whom they have worked successfully in the past. Typically, 
these lists reside on 3" x 5" cards in a file cabinet in each partner’s office. Whenever a 
client’s case requires certain outside expertise, the partners reach for these cards and select 
their favorite people.  

The partner’s remuneration is based in part on their performance—the more successful cases 
they litigate, the more money they make. Moreover, the more experienced and competent 
freelancers they know, the more likely they are to successfully litigate, and thus the more 
likely that attractive clients will seek them out for assistance. In this environment, there is a 
natural tendency to safeguard the names of good freelancers and contractors for one’s own 
accounts. However, there is also the likelihood that by sharing this information, the firm’s 
overall success would increase and everyone would benefit.  

Jeffrey Hudson started the law firm 24 years ago with fellow Temple University graduate 
Bradley Palmer. Jeffrey knows how the freelancing system works. The problem is that each 
attorney squirrels away the names of the people that he or she thinks are really excellent. 
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When it comes to the talent pool, there is no sharing among attorneys. Second-rate people 
may be used on a case because the names of the first-rate people are only known by one or 
two attorneys. If a partner hires a poor freelancer, and the verdict on a case goes against the 
interests of a client, the client may be inclined to look for new legal representation in the 
future, and thus the firm’s profits and reputation suffer.  

Hudson wants to establish some sort of centralized repository for this information. Too much 
time is wasted searching for people with particular skills or knowledge that may already be 
known to some of the partners. The central repository could also contain comments on the 
performance of the freelancer or contractor on prior occasions and other relevant data. 
Hudson would like some sort of scoring system so that freelancers and contractors could be 
rank-ordered. This would ensure that only the best people would be hired to work with the 
firm.  

The partners are not happy with this idea. Sharing these resources with the other partners may 
mean that their favorite people will be unavailable when they need them most. On the other 
hand, a central repository might help them find new resources for assistance about whom they 
did not previously know. Therefore, with somewhat mixed feelings, the partners have agreed 
to support the proposal to build a central repository of contractors. They have responded to a 
memo sent out by Hudson asking them to list the resources they would like to have stored in 
a central database.  

The following fields were identified: First and Last Name, Skill, Hourly Rate, Number of 
Hours Employed for Each Quarter of 2008, Phone Number, Rating (Excellent, Good, OK, or 
Poor) and Initials of the Rater. Hudson reviewed the suggestions and added a field to store an 
additional free form text comment about each freelancer.  

Parts of this database have been identified in the table HUDSON PALMER in the 
SOLVEIT_5 database. Create a new Access database and import this table now.  

Tasks  

There are seven tasks in this case:  

1. Complete the design of the table to store the rating system devised by Hudson. Be sure 
to devise a way to limit the rating field to only 4 categories and to record free-form text 
remarks from the attorneys.  

2. Fabricate and enter hours worked for the existing freelancers or contractors. Enter data 
for three new freelancers or contractors, such as private investigators (PI), process 
servers (PS), legal researchers (LR), or expert witnesses (EW). Enter data for at least the 
first three freelancers in the comments field. Use your initials for the partner who is 
contributing the remarks.  

3. Create a query that shows the contractors sorted first by their skill, then by their rating, 
and then by their name. Include the comment field and print the results of this query.  
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4. Create a report to list all the freelancers and contractors with just the following fields: 
Last Name, First Name, Hourly Rate, the Total Number of Hours Worked, and the Total 
Amount Earned in 2008. Print the report.  

5. Produce and print a report to list all expert witnesses who charge more than 
$250.00/hour. Include in this report the total number of hours this group of freelancers 
worked for Hudson Palmer in 2008. Print the report.  

*6  There are several areas where this system can be enhanced and improved. (What will 
happen next quarter? What if two partners have the same initials?) Make a list of all of 
the improvements you would make, and then pick one and implement it into the 
database.  

*7.  Currently, with the comments in a Memo field, no analysis or data manipulation can be 
performed using the ratings of the freelancers. There may also be conflicting opinions on 
the merit of any one freelancer if they have worked for more than one partner. Devise a 
method to accommodate these differing opinions in such a way that meaningful analysis 
can be performed. Note that this may mean redesigning the database.  

Time Estimates (excluding tasks marked with *)  

Expert:  45 minutes  

Intermediate:  1.25 hours  

Novice:  2 hours  

Tutorial for Database Case 2 Using Access 2007  
In the previous case, you learned to use Table Design View to change the structure of a table 
by adding new fields and setting field properties, and how to use Datasheet View for adding 
and editing records. This case introduces the memo data type and report design. Start Access 
and open the FRIENDS table you used for the Case 1 tutorial to practice the skills you will 
need for this case.  

Using Memo Fields  

Memo fields are used in tables to store free form text and notes. You use a memo field to 
store descriptive or narrative information and even large documents. A memo field in Access 
2007 can hold up to 65,536 characters of text. Creating, entering, and saving data in an 
Access memo field is a very simple procedure. Because of their unstructured nature, memo 
fields cannot be indexed or sorted, but they can be searched. We will look at indexing, 
sorting, and searching in later cases.  
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1. Open the SOLVEIT_CH5 database. Double-click on the FRIENDS table to open it in 

Datasheet View. Click the Design View button  or click View on the Home tab of 
the Ribbon.  

2. Let’s add a new field to the end of the existing table. The name for the new field will 
be COMMENTS and the data type will be Memo. (Review the tutorial for Case 1 if 
you are unsure how to add new fields and select data types.) Notice that the Field 
Size cell in the Field Properties pane does not appear when you select the memo data 
type. Save the changes to the table structure by clicking the Save button or selecting 
Save on the Office menu. 

3. Return to Datasheet View by clicking the Datasheet View button or by clicking 
the View button on the Ribbon. Scroll or tab over to the new COMMENTS field and 
enter text for each record to describe their relationship (e.g. personal or professional 
friend, family member, or a specific familial relationship). Press the down arrow key 
on the keyboard to move to each new record. (Remember that as you move to a new 
record, Access automatically saves the data.)  

Printing Memo Fields  

Memo fields can be printed like any other field in a table or query. To create a query that will 
select only certain fields in the table, including the memo field:  

1. On the Create tab of the Ribbon, in the Other group, click the Query Design button.  

2. In the Show Table dialog box, select the FRIENDS table, click Add, and then click 
Close. 

3. In the FRIENDS field list, select the Last_Name and Comments fields and drag them 
to the design grid. Release the mouse button when the pointer is over the first Field 
cell. 

4. Click the Run button on the Query Tools: Design tab to display the data in the 
Last_Name and Comments fields (see Figure 5-9).  

5. Click the Print button on the Office menu to open the Print dialog box, and then click 
OK to print the query. Then click the Close button at the top right of the query 
window and click No when a warning dialog box asks if you want to save the 
changes to the design of Query 1.  



Database Management Software Cases 
⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯ 

 

 

155

Figure 5-9  

 

Creating Reports in Access  

A more polished look can be achieved by creating an Access report. Reports are the database 
objects in Access specifically designed for printing. Reports can be based on tables and/or 
queries. They are used to provide subtotals and grand totals for numeric fields, and to produce 
summaries of information contained in the database, mailing labels, and presentation quality 
display of your data. Report Wizards speed up the creation, display, and printout by providing 
a series of dialog boxes to help you determine the data you want the report to contain, as well 
as a group of popular style templates from which to choose.  

The items on a report that contain the data for display and printing are called controls. 
Different types of controls are used to display data of the various data types. Controls are 
used to display data from fields, along with the labels that identify this data and the results of 
calculations for report headers and footers that will print identifying information at the top 
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and bottom of every page of the report, as well as group footers that identify a particular 
group of related data. Report controls can also be used to include graphs, pictures, and other 
Access objects.  

1. On the Create tab of the Ribbon, in the Reports group, click Report Wizard to open 
the Report Wizard. 

2. The first Report Wizard dialog box opens. Here you can choose the fields that you 
want to display in the report and decide the order in which you want them to display. 
Notice that, because Fields is the currently selected table in the Navigation Pane, 
Access has selected the FIELDS table as the basis for the Available Fields list. Select 
four fields, Title, First_Name, Last_Name, and City, for inclusion in the report. With 

the Title field selected in the Available Fields box, click the Add Field button  
to add it to the Selected Fields box (refer to Figure 5-10). Next, select the First_Name 

field in the Available Fields box and click  again to add it to the list of selected 
fields. Follow the same procedure to add the remaining two fields. (If you 
accidentally add the wrong field to the report, select the unwanted field and click the 

Remove Field button  to return it to the Available Fields box.) When you have 
finished, click Next.  

3. The second of the six Report Wizard dialog boxes opens. Here you can add grouping 
levels for the data in your report based on one or more fields. Data can be grouped by 
City, for example, so that all contacts that live in a particular city will be grouped 
together in the report. Without adding any grouping levels, click Next.  

4. In the third dialog box, you can impose a sort order on the data in the report based on 
one or more fields. Select City in the first sort order list box and then click Next.  
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Figure 5-10  

 
 
5. In the fourth dialog box, you can choose the layout for the report. Option buttons are 

provided to choose either Portrait or Landscape orientation for the report and a 
Columnar, Tabular, or Justified layout. Select the Tabular layout if necessary, make 
sure the Adjust the field width so all fields fit on a page check box is selected, and 
click Next.  

6. In the fifth dialog box, you can select a style for your report. Select Office if 
necessary and click Next.  

7. In the final dialog box, you can enter a title for your report. By default, Access enters 
the name of the table or query that serves as the record source for the report as the 
title name, which in this case is FRIENDS. Type Report of My Friends.  

8. Make sure the Preview the report option button is selected and click the Finish 
button. Access will generate the report and open it in Print Preview, with the Print 
Preview tab open on the Ribbon. Note that the records are displayed alphabetically 
by City according to the sort order selected in the Report Wizard. Click the Print 
button on the Print Preview tab or select Print on the Office menu to open the Print 
dialog box, and then click OK to print the report. Close the report.  
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How to Use Reports to Display and Print Selected Fields  

You can change the record source for an existing report, which will, in turn, change the 
records the report displays. For example, you can change the record source for the Report of 
My Friends report to the second query created in the tutorial for Case 1 (e.g. Tute1Query2). 
This query filters out all records in the FRIENDS table that do not have the title MR.  

1. On the Navigation Pane, double-click Report of My Friends. (If the Navigation pane 
is not displaying all database objects, then click the down arrow at the top right of the 
Navigation Pane, make sure that Object Type is selected as the Category and then 
click All Access Objects.)  

2. On the Home tab, click the View button arrow and then click Design View to open the 
Design View for the report (see Figure 5-11). Notice there are three Report Design 
Tools tabs on the Ribbon now: Design, Arrange, and Page Setup. 

Figure 5-11  

 

As Figure 5-11 shows, the Report Design View window is divided into sections. The Report 
Header prints once at the beginning of the report. It generally contains the report’s title. The 
Page Header prints at the top of every page in the report and contains the labels or column 
headings. The Detail section contains the records that are being displayed in the report. The 
Page Footer prints at the bottom of each page and often contains calculated controls that 
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display the current system date and time, along with the page number and total number of 
pages in the report. The Report Footer prints once at the end of the report. It often contains 
calculated controls that summarize or total the data contained in the report. Additionally, 
group headers will be automatically added to a report in which records are grouped based on 
like values. You can add group footers to include summary information about the group such 
as Count, Sum, or Average. We will look at report groups in a later tutorial.  

3. On the Report Design Tools: Design tab, click the Property Sheet button on to open 
the property sheet for the report. Report properties define the data source for the 
report, as well as its overall appearance.  

4. Click the Data tab on the property sheet if necessary. Click in the Record Source 

property settings box and click the list arrow  to open a list of the available data 
sources in the FRIENDS database. Select the second query you created in the Case 1 
tutorial (Tute1Query2) to change the record source for the report (see Figure 5-12.)  

5. Close the property sheet by clicking the  in the top right corner.  

6. On the Report Design Tools: Design tab, in the Views group, click the arrow on the 
Views button and select Print Preview to view the new report. A reduced data set 
displays based upon the criteria set up in the query, but the sort order based on the 
City field and the report style selected in the Report Wizard remain.  
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Figure 5-12  

 

7. On the Print Preview tab of the Ribbon, in the Print group, click the Print button to 
open the Print dialog box. Click OK to print the new report.  

8. Click the Office button and then click Save As to open the Save As dialog box. Type 
Tute2Report2 in the top text box and click OK. Close the report and the FRIENDS 
table.  

Using Expressions in Reports  

Calculated controls are used to display the results of expressions that can be built using 
Access functions, mathematical operators, raw values, and any values contained in the fields 
in the report. For example, the expression = [UnitCost]*[Quantity] multiplies the contents of 
the two fields with these names and displays a single value as the result. A function is a 
predefined formula that helps simplify the process of building expressions. For example, the 
function Sum will add all of the values specified. The Now function in the Page Footer 
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section, shown in Figure 5-11, returns the current date as stored in your computer’s system 
clock.  

You can create calculated controls using expressions in one of three ways:  

• By typing an expression directly into a text box control  

• By entering an expression into the Control Source property for a control  

• By using the Expression Builder to help you to create the expression  

To learn and practice the skill of creating calculated controls using expressions, we will use 
the first method and the sample table HARDWARE provided in the SOLVEIT_CH5 
database. First, create a new empty database with the name HARDWARE.ACCDB and then 
import the HARDWARE table from the SOLVEIT_CH5 database. (If you still have tables or 
reports open from the FRIENDS database, save and close them, and close the FRIENDS 
database.) 

1. In the opened HARDWARE database, double-click the HARDWARE table to open 
it in Datasheet View. There are four fields: Invoice, Item, UnitCost, and Quantity. 
Press [F11] to view the Database window.  

2. Open the Create tab on the Ribbon. In the Reports group, click Report Wizard and 
use the Report Wizard to create a new report using the HARDWARE table as the 
record source. Include the fields Invoice, UnitCost, and Quantity. Sort the records by 
the Invoice field, use the Tabular layout and the Office style, and give the report the 
title Calculating Total Cost. Click Finish. The report is generated and opened in Print 
Preview.  

3. On the Print Preview tab, click the Close Print Preview button to switch to Report 
Design View.  

To practice using expressions, we will create a field that calculates the total cost for an 
ordered hardware item by multiplying UnitCost by Quantity. Since this calculation, or 
expression, will use the values in two existing fields to calculate a new value, we must create 
a calculated control. A calculated control contains an expression and displays the result of 
that expression when the report is opened.  

4. Open the Report Design Tools: Design tab on the Ribbon if necessary. Click the Text 
Box button in the Controls group. Click once with the Text Box pointer at the 5-inch 
mark on the horizontal ruler in the Detail section of the report. An unbound text box 
control and a label control to identify it are added to the report. The label text (Text 
11) will vary depending on the number of controls on the report. Click the label 
control to select it and press the [Delete] key on the keyboard. You will add a label 
for the calculated control to the page header later. 

5. Unbound controls are not linked to any existing field in the record source or sources 
for the report. They are used to display the results of calculations, text, or graphics. 
Click inside the unbound text box to get a blinking insertion point (called an I-beam). 
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Type =UnitCost*Quantity, making sure to begin the expression with an equals sign, 
and press the [Enter] key. Access automatically adds the correct syntax for you by 
enclosing each field in square brackets. Access is not case sensitive, so it does not 
matter if you enter your field names in upper or lowercase. You must, however, spell 
them correctly and use the correct spacing!  

All expressions in Access must begin with an = sign. The asterisk is used to denote 
multiplication. A listing of other operators and functions used in Access is presented at the 
end of this tutorial.  

6. You have now created a calculated control. The Detail section of your report should 
resemble Figure 5-13.  

7. You will now add a label control to the page header to identify the calculated control. 
Click the Label button on the Ribbon. Click the Label pointer once in the Page 
Header section of the report at the 5.5-inch mark on the horizontal ruler. Type 
TOTAL.  

8. Double-click the new calculated control in the Detail section to open the property 
sheet for the control. Click the Format tab. Click in the Format property settings box. 
Click the list arrow and select Currency on the list. Close the property sheet and 
switch to Print Preview. Your report should look similar to Figure 5-14. Save the 
changes and close the report.  

 

Figure 5-13  

 

Note: If the field names contain spaces, you must enclose them in square brackets 
because Access will not recognize them as field names (e.g. [Time to Market]).  



Database Management Software Cases 
⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯⎯ 

 

 

163

Figure 5-14  

 

Calculations in Queries  

A more rapid way of achieving the same result is to create a query that includes the calculated 
field you want to display in the report and then to use the query as the record source for the 
report.  

1. In the HARDWARE database window, open the Create tab of the Ribbon and click 
Query Design. Add the field list for the HARDWARE table to the Select Query 
window and close the Show Table dialog box. Drag three fields—Invoice, UnitCost, 
and Quantity—to the design grid.  

2. In the fourth Field cell, type TOTAL: [UnitCost]*[Quantity]. Your query window 
should look like Figure 5-15.  
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3. Click the Properties Sheet button on the Query Tools: Design tab of the Ribbon to 
open the properties sheet for the calculated field. On the General tab, click in the 
Format property settings box. Click the list arrow and select Currency. Close the 
properties sheet.  

4. Click Run on the Query Tools: Design tab (Results group) to run the query. Save the 
query as CalculatingTotalCost. 

5. Use the Report Wizard to  create a new report called Calculating Total Cost 2 using 
the query as the data source for the report  

Figure 5-15  

 

Expressions can play many roles in Access, and they can be used in virtually every type of 
database object. For example, you can use expressions in Table Design View to define 
default values for fields. In queries, expressions can be used to create calculated fields and 
criteria. The table below lists only those operators likely to be used in Solve it! For a more 
complete list, search the Access Help facility using the term operators. 

Operators in Access  

An operator in an expression describes the type of action that the expression should perform 
or the way in which a comparison between two values should be carried out. Access has four 
kinds of operators: Arithmetic and Text, Comparison, Logical, and Miscellaneous. The table 
below classifies, lists, and explains these operators. For a more complete list of operators, 
consult the Access Help facility.  
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Arithmetic and 
Text 

 

^ Raise one number to the power of the other (exponentiation) 
* Multiply two numbers 
/ Add two numbers 
+ Divide two numbers 
- Subtract two numbers 
Mod Divide two numbers and return the remainder 
& Concatenate: join two strings of text 
  
Comparison  
< and <= Less than; less than or equal to 
> and >= Greater than; greater than or equal to 
= and <> Equal to: not equal to 
  
Logical  
And Both comparisons are True 
Or One comparison or the other is True 
Xor One comparison or the other is True , but not both 
Not The comparison is not True 
  
Miscellaneous  
Like Text matches a pattern (Use with wildcard symbols ? and *) 
Is Comparison is True (e.g.: is Null) 
Is Not Comparison is not True (e.g.: not Null) 
 

Functions in Access  

A function in Access performs a calculation on data and returns the result of that calculation. 
There are over 100 functions available in Access in eight different categories. The table 
below lists only those likely to be used in Solve it! For a complete list, search the Help files 
using the keywords functions and reference.  

Date/Time  
Date Returns current date 
Now Returns current date and time 
  
Logical  
IF Tests and returns a value based on whether an argument is True 

or False 
Choose Selects a value from a list based on the content of its argument 
  
Aggregate  
Avg Average 
Count Count how many 
Sum Sum total 
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The Access Form and Report Design Tools 

The buttons displayed in the table below appear in the Controls group on the Report Design 
Tools: Design tab. You use them to create labels, text boxes, option buttons, etc. for forms, 
subforms, and other Access objects.  

 
Select Objects Use to select a control, section, or form. Click this tool to unlock a control button 

that you have locked down. 

 
Control Wizards Turns control wizards on or off; Use control wizards to help you create a list box, 

combo box, option group, command button, chart, subreport, or subform. 

 
Label A control that displays descriptive text, such as a title, a caption, or instructions on a 

form or report; Access automatically attaches labels to the controls you create. 

 
Text Box Use to display, enter, or edit data in either a form or report's underlying record 

source, display the results of a calculation, or accept input from a user. 

 
Option Group Use along with check boxes, option buttons, or toggle buttons to display a set of 

alternative values. For example, you can use an option group to specify whether an 
order is shipped by air, sea, or land. 

 
Toggle Button Use as a stand-alone control bound to a Yes/No field, an unbound control for 

accepting user input in a custom dialog box, or as part of an option group. 

 
Option Button Use as a stand-alone control bound to a Yes/No field, an unbound control for 

accepting user input in a custom dialog box, or as part of an option group. 

 
Check Box Use as a stand-alone control bound to a Yes/No field, an unbound control for 

accepting user input in a custom dialog box, or as part of an option group. 

 
Combo Box Combines the features of a list box and a text box; You can type in the text box or 

select an entry in the list box to add a value to an underlying field. 

 
List Box Displays a scrollable list of values; In Form View, you can select from the list to 

enter a value into a new record or to change the value in an existing record. 

 
Command Button Use to perform actions, such as finding a record, printing a record, or applying a 

form filter. 

 
Image Use for displaying a static picture on a form or report. Because a static picture is not 

an OLE object, you can't edit the image inside Microsoft Access once you've added 
it to a form or report. 

 
Unbound Object Use to display an unbound OLE object, such as a Microsoft Excel spreadsheet, on a 

form or report. The object remains constant as you move from record to record. 

 
Bound Object Use to display OLE objects, such as a series of pictures, on a form or report. This 

control is for objects stored in a field in either the form or the report's underlying 
record source. A different object displays on the form or report as you move from 
record to record. 

 
Page Break Use to insert or remove a new page on a form, printed form, or report. 

 
Tab Control Use to create a tabbed form with several pages or tabbed dialog box (such as the 

Access Options dialog box on the Office menu). You can copy or add other controls 
onto a tab control. Right-click on the Tab control in the design grid to modify the 
number of pages, the page order, the selected page’s properties, and the selected tab 
control properties. 



Database Management Software Cases 
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Subform/Subreport Use to display data from more than one table on a form or report. 

 
Line Use on a form or report to emphasize related or especially important information. 

 
Rectangle Use for graphic effects, such as grouping a set of related controls on a form, or for 

emphasizing important data on a report. 

 
Insert ActiveX 
Control 

Adds an ActiveX control (such as the Calendar control) to a form or report; 
ActiveX controls are stored as separate files. 

 


